
ImageLinker   Tutorial
A walk through tutorial with ImageLinker -  an OSSIM application

Introduction
ImageLinker Background

ImageLinker is  a GUI based application demonstrating the power of the OS-
SIM open source software library.  It is one of many programs that have been 
built on top of the functionality in OSSIM.  Users are encouraged to register online at 
http://www.ossim.org and join the collaborative community there.  The site is the focal point for 
software development, user support, and related information.

ImageLinker is an application for viewing and processing remote sensing and Geographical Informa-
tion System (GIS) data.  Built on the underlying OSSIM library. Capabilities include advanced re-
mote sensing, photogrammetry, and image processing.  Underlying design goals and capabilities are 
covered in more detail in the Design Goals section of this document.

ImageLinker brings out many of the underlying functions through commands that are accessed 
through pull down menus and dialogs.  ImageLinker also allows the user to construct and manipulate 
complex image flows through the Visual Chain Editor (VCE).  The VCE allows the user to dynami-
cally connect and re-order multiple “image chains” through the visual chain editor canvas.  
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Each function is represented by a thumbnail that reflects the state of the imagery at that point.  Us-
ers can double click any function to access custom dialogs and parameters.  Projects can be saved 
and retrieved at will and later used as processing templates for batch processing.

ImageLinker also supports a plugin architecture that allows new functions and processes to be 
loaded at runtime.  The design of the plugins allows scientists and developers to quickly add new 
functionality without the need of learning the internals of the OSSIM software libraries.

In addition to viewing and manipulating image chains, ImageLinker can generate output products by 
passing the parameters to the igen command line tool (called through menu commands).

ImageLinker and OSSIM are open source software projects that are being widely deployed in various 
government and commercial organizations.  

Preparation and Setup

Refer to the OSSIM Installation document for detailed instructions on installing OSSIM and ac-
quiring some sample data.  This first tutorial uses data that can be found on ftp.remotesensing.org.

 Login as anonymous leaving your email address as password.  

Then cd incoming/ossim/sample_data to find some tutorial data sets.  From a terminal window you 
can typically perform the following commands:

	

 ftp ftp.remotesensing.org

	

 login:  anonymous

	

 Password: <youremail@yourcomputer.com>

	

 cd ossim

	

 cd sample_data

	

 cd map_and_sanfran

	

 ls

you should see:

-rw-r--r--   1 ftpuser  ftpusers   2790904 Jan 31  2003 map_and_sanfran.tar.gz

	

 get map_and_sanfran.tar.gz

Wait for the download to complete then:

	

 exit   

to exit the ftp command
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The file should download to your local disk.  You might want to place it in a separate directory

	

 mkdir testdata
	

 mv map_andsanfran.tar.gz testdata
	

 cd testdata
	

 ls

unzip and untar the file

	

 gunzip map_and_sanftan.tar.gz
	

 tar xvf map_and_sanfran.tar

perform an ls to see that the files are there

	

 ls

	

 highres_utm_map.geom            	

 sanfran.geom
	

 highres_utm_map.ovr             	

 sanfran.ovr
	

 highres_utm_map.tif             	

 sanfran.tif
	

 highres_utm_map_readme.txt      	

 sanfran_readme.txt
	

 map_and_sanfran.tar

These files have been prepared as a test set for the ImageLinker program.  ImageLinker will take 
advantage of auxilliary files if they are present.  There are several OSSIM command utilities to cre-
ate these files for data sets.  Included in the sample data set is a raster map and a section of a satellite 
image over San Francisco.  The initial files were sanfran.tif and highres_utm_map.tif - both geotiff 
files.  GeoTiffs are tiffs that have geospatial tags embedded in the file.

The respective ovr files are overview files containing reduced resolutions sets.  These files can be 
generated with the img2rr (image to reduced resolution) command line utility.  The geom files con-
tain geometry information and were created with the create_geom command.

Histogram files can be created with create_histo.

The readme.txt files are human readable files about the data sets.

These two files will be used to demonstrate some of the basics of ImageLinker.

	

 3



A Walkthrough Tutorial  
Starting the Program
Double clicking the application will bring up an 
empty project window.  ImageLinker can support 
multiple projects, each one will invoke a master pro-
ject window.  Images, image chains, and visual chain 
editors for each project will be contained within the 
project window.  The main project window can be re-
sized by the user, minimized and maximized.

 

File Opening 
For operating systems that support drag and drop, 
files that OSSIM understands can be dragged from 
the desktop to the project window and an associated 
image chain and display will be automatically opened 
up.  Multiple files can also be selected and dragged as 
a group.
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Menus 
The application will display a menu bar with the main 
menu categories as shown above.  Each of the menus 
will be covered in more detail:

File Menu
The project menu contains all of the commands re-
lated to manipulating projects.  Project files can be 
thought of as sessions.  Multiple images can be loaded 
and filters and parameters can be applied to their re-
spective image chains.  All of these settings including 
window positions and user settings are captured and 
saved at will when the user saves a project.  A project 
typically has a .prj extension.

Open Image...
The Open Image menu item invokes a file dialog box 
that allows the user to navigate the file system and 
open an image for ingest and display in the project.  
When the image is loaded an image chain is created 
and can be seen in the Manager dialog.

A display is also created in the project window.  The 
display windows have a number of capabilities and 
menus that can manipulate the underlying image 
chain for the display.

Each display window contains a title bar that denotes 
the source.  Display menus and menu items operate 
on the underlying image chain for the window.  The 
window also has a number of modes for panning and 
zooming.  When a display is initially created it  de-
termines if there is an underlying geographic context 
associated with the imagery.  If none is available 
through associated metadata or internal geo-specific 
tags, a dialog is presented to the user asking if a de-
fault geographic projection should be assigned to the 
image.
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Zoom and Pan Modes  
The window palette con-
tains two icons for selecting zooming and panning 
modes for the display.  Select the mode then control 
by clicking in the content of a display.  Shift click will 
cause the zoom mode to zoom out.  Dragging a rec-
tangular area will zoom the display to that area of in-
terest.

Fit
The Fit button calculates and scales the image so that 
the entire coverage is visible in the display window as 
shown on the left. 

In this example a map and a Landsat image have been 
scaled to fit in the display windows.

Full Res
The full res button scales the image to full resolution 
centered about the last cursor click in the window.  
Each geographic image has a full resolution parameter 
which defines the native resolution mode of the data 
set. 

In this example the Landsat image on the left was 
zoomed to full resolution.
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Propogate
The propogate mode syncs the views of coincident 
geographic data sets to the same scale and resolution 
as the selected window.  It transmits a command to 
the other windows to present themselves in the same 
view as the window where the button was pressed.

In this example the full resolution view of the Landsat 
image on the right was propogated to the map on the 
left.  Both images are presented in the same scale and 
area of coverage.  

Resamplers

Display 
Menus

Several menus are available on the display window.  
Each will be covered in more detail below:

View

This dialog displays and modifies the projection 
and image of the displayed image.  Transforming to 
another projection / datum is as simple as selecting 
the desired output from the pull down menus.  Pa-
rameters for resolution, origin, etc are also available 
from this dialog.  OSSIM application are projec-
tion and resolution independent.  All transforma-
tions and resamplings are performed automatically 
to meet the needs of any display.

	

 7



Geometry Adjustment
This dialog is available for sources that are derived 
with sensor models.  OSSIM has support for rigorous 
sensor models and adjustable parameters.  For this 
particular example both inputs are map projected 
products.  The dialog shown reflects the adjustable 
parameter dialog for a Landsat 7 model.

Image Chain
OSSIM support dynamic image chains.  This will be-
come more apparent later in the demonstration with 
the visual chain editor.  An image chain typically be-
gins with a geo-spatial file on disk and is connected 
through a series of band selectors, caches, filters, and 
resamplers.  This dialog shows the current image 
chain (right side) associated with the particular dis-
play.  The left hand list contains a list of all of the reg-
istered image objects.

Image Info
This dialog contains geometry, projection and vertex 
information on the displayed image.  Each of these 
sections are available through the tabbed interfaces 
on the dialog.  The geometry contains information 
the source file type, radiometry, pixel dimensions, and 
 pixel values.  The project tab provides information 
about the projection values of the source, and the ver-
tices display the pixel values of the corners of the 
valid data within the image file.

Layers
Vectors
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Swipe Menu
The Swipe menu of the display window allows the 
user access to commands related to the swipe func-
tion.  Two geographically coincident data sets can be 
stacked and rapidly compared by moving the cursor 
back and forth over the content region of the window. 
 The top layer is covered and uncovered as the mouse 
is moved.

Add Layer
The add layer menu item invokes a layer chooser dia-
log.  Select the layer that you wish to place on top of 
the current display window and press the Apply but-
ton.

Remove Layer
Once an additional layer has been added it can be re-
moved using this command.  Simply select the image 
chain to be removed and click the Apply button.

Horizontal
Swipe modes are ideal for change detection or rapidly 
comparing two geographic coincident data sets.  As 
the cursor is moved back and forth the top layer cov-
ers and uncovers the base layer.

These are examples of swipes.  As the cursor is 
moved, the top layer covers the base area following 
the cursor.

Vertical
A vertical swipe mode can be entered by selecting the 
vertical swipe menu item.

Box 
Not currently implemented…
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Circle
Not currently implemented…

Band Selection
The band selection dialog is used for selecting which 
source bands are to be mapped to designated output 
bands.  Modes exist for grey scale (select one input 
band), True (select three bands for red, green, and 
blue channels), and N band (select and arbitrary num-
ber of bands.  The bands can be reordered as well.

Brightness Contrast
Not implemented

Correction-->Topographic
Used for providing topographic illumination correc-
tion to imagery based on the normals generated from 
the underlying elevation surface.  Used as an error 
removal process in preparation for material classifica-
tion.

Histogram Operations
ImageLinker contains a dialog for viewing and ma-
nipulating image histograms.  The current version of 
ImageLinks needs to attach to an external histogram 
file.  That file can be created with the command line 
application create_histo.  The dialog allows the set-
ting and application of clip points and input output 
curves.  

Hue Saturation Intensity Adjustments
This dialog provides color adjustments via hue, satu-
ration and intensity sliders. The changes can be ap-
plied to individual or multiple channels by selecting 
the  radio buttons on the top.  Clip points and white 
object clip points can also be directly adjusted.  The 
enable checkbox makes the changes active on the 
parent display.
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Resampling -->Propogate
This command propogates the current windows re-
sampler selection to other display windows in the pro-
ject.

Fusion
Currently Disabled

Export-->Image Generator
Igen is the command for generating product output.  
The menu item allows the user to set parameters for 
product output, save those specifications to an exter-
nal spec file and/or run the igen  command line pro-
gram to build the specified product.  Products are ac-
tually generated by an OSSIM command line program 
called igen.  This program is fired off in the back-
ground so the user can return to working with Im-
ageLinker while the product is prepared.  

output file
The output file field allows the user to set the name 
of the output product file.  

Set output file
A button that applies the output file name

gsd: 
This allows the user to specify the output resolution 
of the product.  This is known as gsd or ground sepa-
ration distance.  This value will cause the image chain 
to be resampled to the desired output resolution 
specified in meters.

scene rect
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The output scene rectangle can be projected back on 
the image display given the current settings of the 
dialog.  Alternatively the user can drag the cursor 
across the display and define a bounding rectangle and 
the values for line and sample will be updated in the 
dialog.  Pressing the scene rect button projects the 
current dialog parameters back on the image display.  
All of this ultimately determines the extent and reso-
lution of the output product that will be generated by 
igen.

Lines
Defines the number of lines (rows) of pixels to be 
generated in the output product.

save spec file
This button invokes a dialog for specifying and saving 
a spec file.  A spec file contains the specifications re-
quired to build the current image chain and produce 
the specified product.  The spec file can be manually 
fed to igen from the command line to build the 
product.  A spec file is a text file that can be inspected 
and modified if desired.  It is a list of keyword value 
pairs that specifies all of the source material, func-
tions, and associated parameters for image generation.

Samples
Specifies the number of pixel samples (columns) in 
the output product.  Note that it is also possible to 
set the lines and samples in the dialog box by dragging 
the cursor in the display window and defining an out-
put product rectangle.

run igen
Pressing this button executes the current parameters 
in the display chain and the dialog box by feeding 
them to the igen command line product generator.

output type
This pull down menu allows the user to select the de-
sired output file format for the generated product.  
This list contains file formats that are supported by 
the OSSIM libraries.
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Close
This button closes the dialog box.

Help

This concludes menus that are associated with the 
Display window.  Now back to the main menu bar 
continuing on with the File Menu...

Open Project
The Open command invokes a file navigation dialog 
allowing the user to navigate the file system and open 
a .prj project file.   A project file saves the state of 
your session so that you can retrieve it later.

Close
Closes the active project and asks if you would like to 
save the project file.

New
Creates a new project and associated project window.  

Save 
Saves the current project and invokes a dialog box if 
the project hasn’t been assigned a name. 

Save As…
Invokes and Save dialog box and allows the user to 
assign a new name to the project.

Layer Menu
Images and image displays may have multiple layers.  
Opening an image establishes the initial base layer for 
a window.  Other images, maps, and vectors can be 
overlaid or combined  in various ways  as additional 
layers.  The Layer menu contains the commands that 
are related to layers.
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Manager
The Manager menu item invokes a Manager dialog 
that displays all existing image chains that are open 
within the current project.  Image chains can be de-
leted, duplicated, mosaicked, blended and feathered 
within this dialog box.

It is also possible to drag and drop image chains from 
the manager into the Visual Chain Editor.  Dragging 
and dropping from the manager to the VCE creates a 
copy of the image chain in the VCE.

Display Button
The Display button brings the selected image chains 
display window to the front of the project window.  
Often when dealing with large numbers of images, it 
is easier to find a partiular file in the  manager display 
list and bring it to the front with this method.

Delete Button
Deletes the selected image chains and their associated 
display windows.

Duplicate Button
Makes a copy of the selected image chain.

Mosaic Button
Creates a mosaic in a new display window of the se-
lected image chains.  A new image chain will be cre-
ated and added to the Manager window for the mo-
saic display.

Blend Button
Creates a blended mosaic in a new display window of 
the selected image chains.  A new image chain will be 
created and added to the Manager window for the 
blended display. The resultant display mosaics the se-
lected images averaging the pixel values where they 
overlap.
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Feather Button
Creates a feathered mosaic in a new display window 
of the selected image chains.  A new image chain will 
be created and added to the Manager window for the 
feathered display. The resultant display mosaics the 
selected images transitioning the pixel values from 
one image to the other where they overlap.

Histogram Match
Selecting this menu item brings up an image chain 
display list.  Select the image chains to be mosaicked 
together and histogram matched.  The Apply button 
will create a new image chain and open a display win-
dow that displays the histogram matched mosaic.

Combine Sub-menu
The combine sub-menu holds menu items that invoke 
various image chain combiner methods.

Mosaic
The mosaic combiner creates a new chain that creates 
an output mosaic fed by the selected input image 
chains.  This combiner simply creates a list that pro-
vides A over B mosaicking.  The images are stacked 
on top of each other first to last as they are selected.  
Image ordering can be changed from the mosaic dis-
play menus.

Blend
The blend combiner creates a new chain that creates 
a blended output mosaic fed by the selected input 
image chains.  This combiner averages the image 
chains where they overlap.

Feather
The feather combiner creates a new image chain that 
creates a feathered mosaic.  In the overlapping re-
gions the imagery is transitioned gradually from A to 
B changing the relative contribution of the input im-
agery.  Effectively creating a gradient from A to B in 
the overlap areas.
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Merge Bands
The merge combiner creates a new image chain that 
blends the individual input bands from the selected 
image chains together.

Ortho
An ortho combiner is useful in mosaicking abutting 
tiles in image space before reprojecting the output 
mosaic.  If all of the times are in the same scale and 
map projection they can be combined seamlessly in 
image space before map reprojections are made.  
Otherwise, gaps may occur due reprojection if the 
individual tiles are reprojected before being combined 
in an output mosaic.  As with the other combiner 
methods, simply select the image chains to be com-
bined to create the orthomosaic.

Fusion Sub-menu
The Fusion sub-menu holds the image chain functions 
that provide various types of specialized image fu-
sions.  ImageLinker supports a dynamic plugin archi-
tecture.  If these modules are available they will be 
loaded at runtime and their associated menu items 
will be enabled.

Color Normalized
IRS
Adaptive High Pass
Adaptive High Pass Simulated Blue
Spot
Radar

Correction Sub-menu
Atmospheric
Topographic
Elevation Sub-menu
Hillshade
Normals
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Visual Chain Editor (VCE)

New Chain
The visual chain editor canvas provides a visual inter-
face to building and manipulating image chains.  
When selecting the New chain menu item a blank 
canvas dialog is invoked.  Chains can be manually 
built from dragging individual components from the 
Components dialog and existing chains can be repli-
cated in this environment from the Manager menu 
item.  Simply select and drag existing image chains 
from the Manager dialog on to the VCE canvas.

The screenshot shown at the left demonstrates the 
results of a Landsat image, map image, and mosaic 
image chain copied to the VCE canvas.

Each icon shows a miniature of that point in the im-
age chain.  Double clicking any object will bring up a 
Property editor for that function.  Objects can be dy-
namically connected and disconnected through the 
Visual Chain Editor.  Icons provide cut, duplicate and 
alignment functions for selected objects or connec-
tions.  Groups can be selected and repositioned on 
the canvas.

Components
The Components menu item invokes a tabbed VCE 
Components dialog which holds individual compo-
nents that can be dragged to the VCE canvas and 
connected.

The tabbed interface allows the user to select groups 
of components by overall function.  Currently the 
components are grouped in the following categories:

• Loaders
• Combiners
• Filters
• Exporters
• Displays
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Utilities Menu
Datum Converter
Not implemented…

Elevation Manager
This menu item invokes an elevation manager dialog.  
Multiple trees of elevation data can be staged and 
prioritized with this interface.  When using sensor 
models, elevation is automatically selected based on 
the definitions in this list and loaded on demand to 
provide coverage for the loaded imagery.  Automatic 
precision terrain correction is performed as the im-
agery is projected through the sensor models and in-
tersected with the elevation models.

Unit Converter
A Unit Converter dialog utility is provided to perform 
arbitrary unit conversions.  

Simply select a field, enter a value and equivalent val-
ues will be calculated in the other fields.
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Window Menu
This menu holds various commands for management 
of windows within the project canvas

Cascade
Rearranges the 
windows so 
they cascade in 
the project can-
vas.

Tile
Rearranges the windows to they are tiled within the 
project canvas.

Minimize All
Minimizes all windows into buttons at the bottom of 
the canvas window.

Restore All
Maximize
Refresh All
Close All

Help

Next Steps
Additional tutorials are available in the OSSIM 
documentation section to guide you through specific 
projects.  Please refer to www.remotesensing.org and 
www.ossim.org for the latest developments and sup-
port.
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